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ВВЕДЕНИЕ 

Система внутренних воздушных потоков газотурбинного двигателя включает в себя 

системы охлаждения горячих деталей, наддува уплотнений, разгрузки радиально-упорных 

подшипников и др. Все эти системы, как правило, между собой связанны и процессы, 

происходящие в одной системе, могут влиять на другие. Связанные системы рекомендуется 

рассчитывать совместно. Расчѐт параметров в полостях воздушных систем должен проводиться 

с учѐтом подогрева воздуха от стенок каналов и   поэтому требуется проведение теплового 

анализа. Основными элементами газотурбинных двигателей, служащими для разделения 

полостей с разными значениями давлений, являются уплотнения. Лабиринтные уплотнения 

широко применяется из-за их простоты и низкой вероятности загрязнения твѐрдыми частицами. 

В газотурбинных двигателях их количество может достигать нескольких десятков. Радиальный 

зазор в лабиринтных уплотнениях играет существенную роль при расчѐте расходных 

характеристик и в зависимости от режима работы двигателя не остаѐтся постоянным. Поэтому 

иногда для определения величины радиального зазора требуется проводить также расчѐт 

напряжѐнно-деформированного состояния. 

В данном пособии приведены краткие сведения о воздушных системах. Приведены 

методики расчѐта гидравлических параметров, теплового состояния и напряжѐнно-

деформированного состояния элементов двигателя. 
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1 СИСТЕМА ВНУТРЕННИХ ВОЗДУШНЫХ ПОТОКОВ 

Под системой внутренних воздушных потоков (СВВП) [1] будем понимать совокупность 

воздушных потоков, использующих рабочее тело для обеспечения функционирования 

двигателя и всего ЛА (ЭУ), которое отбирается из проточной части АД и ЭУ и непосредственно 

не используется при создании тяги (мощности). 

СВВП состоит из подсистем, каждая из которых выполняет свою собственную функцию. 

Все подсистемы взаимосвязаны либо напрямую, либо косвенно через газовоздушный тракт 

двигателя и стенки, передающие тепловой поток от одной системы к другой. Поэтому расчет 

всех подсистем целесообразно проводить в составе системы внутренних воздушных потоков в 

целом.  

1.1 Классификация системы внутренних воздушных потоков  

по функциональным признакам 

Отбираемый воздух из-за различных ступеней компрессора выполняет разнообразные 

функции: 

 охлаждение; 

 наддув уплотнений масляных полостей и охлаждение опор; 

 разгрузка радиально-упорных подшипников от осевой составляющей силы; 

 наддув трактовых уплотнений турбины НД; 

 система управления радиальными зазорами в турбокомпрессоре; 

 противообледенительная система двигателя; 

 самолетные нужды. 

1.1.1 Охлаждение деталей горячей части двигателя 

Уровень совершенства двигателя прямопропорционален температуре газа перед турбиной. 

С повышением 
*T , температура элементов, как турбины, так и компрессора так же 

увеличиваются. Высокие температуры деталей двигателя значительно снижают способность 

восприятию механической нагрузки и, следовательно,  ресурс детали. 

Различают следующие способы охлаждения лопаток: 

 конвективное охлаждение; 

 конвективно-пленочное охлаждение; 

 пористое охлаждение. 

Способы конвективного охлаждения: 

 Оребрение стенок канала; 

 Столбики- турбулизаторы; 

 Лунки на поверхности канала; 

 Струйный обдув; 

 Вихревая матрица. 
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Предварительное охлаждение воздуха 

Охлаждение лопаток первой ступени турбины ВД чаще всего происходит воздухом, 

отбираемым из-за компрессора ВД. Температура сжатого воздуха напрямую зависит от 

суммарной степени повышения давления и на современных двигателях достигает существенной 

величины. Для снижения температуры охладителя, а, следовательно, и его требуемого расхода 

на двигателях используют следующие приемы: 

 Предварительная закрутка охлаждающего воздуха; 

 Использование теплообменников. 

Предварительная закрутка охлаждающего воздуха 

Использование подкручивающей решетки позволяет снизить температуру воздуха на 

60…90К [2], определить которое можно по следующей формуле: 
2

* *

1

2 cos

2 ( 1)
p C w

U C U
T T T

R k k




  
   

  
,  

где  

С – скорость воздуха в абсолютном движении; 

U – окружная составляющая абсолютной скорости воздуха; 

  - угол выхода потока из подкручивающей решетки; 

R – газовая постоянная; 

k – показатель изоэнтропы. 

Центробежные силы способствуют подогреву воздуха, которое может достигать величины 

до 70 К [2]. Предварительная закрутка в направлении вращения позволяет избежать этого 

повышения. 

Суммарное снижение температуры воздуха при использовании подкручивающей решетки 

по сравнению со схемой без нее составляет [1]. 

K160...90TTT
р.ц.с.сум
 , 

где  

ц.с.
T  - изменение температуры от действия центробежных сил; 

p.
T  - изменение температуры заторможенного потока воздуха от введения 

подкручивающей решѐтки. 

Оптимальное расположение радиуса подкручивающей решетки зависит от решения 

конструктора: если основной задачей является минимальная температура охладителя, то 

предпочтительно расположение на более высоком радиусе; если же целью является 

поддержание давления на выходе с минимально возможными утечками воздуха, то 

предпочтительно расположение на более низком радиусе. 

Для уменьшения температуры воздуха поступающего на охлаждение рабочих лопаток 

первой ступени турбины ВД на двигателе НК-93 подкручивающая решетка расположена на 

периферии, а проблема повышенных утечек через лабиринтные уплотнения решена путем 

использования неизбежных утечек закомпрессорного воздуха (рис. 1). 
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Рис.1. Схема подвода охлаждающего воздуха 

к рабочим лопаткам первой ступени турбины ВД двигателя НК-93 

Использование теплообменников 

Теплообменник снижает температуру охладителя воздухом наружного контура. Несмотря 

на загромождение второго контура и увеличение массы, установка теплообменника позволяет 

уменьшить удельный расход топлива.  Снижение температуры воздуха в теплообменнике для 

двигателя Ал-31Ф составляет 150
0
С на земле и 220

0
С в полете [3]. 

Охлаждение дисков турбины 

Охлаждение дисков турбин преследует следующие задачи: 

1) Уменьшение подвода тепла из проточной части к ободу диска для обеспечения 

необходимого коэффициента запаса прочности; 

2) Уменьшение неравномерности температурного поля диска. 

Первую задачу можно решить путем продувкой воздуха через зазоры в замках лопаток 

(рис. 2.). 

 Подвод воздуха к диску можно разделить на следующие схемы: 

 Радиальный обдув боковой поверхности; 

 Струйный обдув боковой поверхности; 

 Струйно-радиальный обдув боковой поверхности; 

 Продувка воздухом между диском и дефлектором. 

Дефлектор может быть установлен как с одной стороны, так и с обоих (рис. 2). Так же 

различают вращающиеся дефлекторы и неподвижные. 

Частичное отключение воздуха 

Площади каналов прохода охлаждающего воздуха проектируются для максимального 

высокотемпературного режима работы двигателя, именно там где требуется наибольший 

расход охладителя. Наиболее продолжительным является режим крейсерского полета, где 
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температура газов перед турбиной существенно меньше и, следовательно, потребный расход 

воздуха для охлаждения лопаток турбин так же ниже. Для повышения топливной 

эффективности на некоторых двигателях применяют частичное отключение охлаждающего 

воздуха. 

Примером может служить двигатель НК-56 (рис. 2), где частичное отключение 

охлаждающего воздуха применяется при охлаждении сопловых аппаратов и лопаток рабочего 

колеса первой ступени. 

 

Рис. 2. Охлаждение СА и РК первой ступени турбины ВД ТРДД НК-56 

1.1.2 Наддув уплотнений масляных полостей и охлаждение опор 

Работоспособность опоры зависит, прежде всего, от параметров сред, окружающих и 

находящихся внутри масляной полости. 

Величина давления воздуха, предназначенного для наддува уплотнений, должна 

находиться в определенном диапазоне. Нижняя граница устанавливается требованием 

гарантированной герметизации масляных полостей на всех режимах работы двигателя. Верхняя 

граница ограничивает повышенные значения расхода воздуха, поступающего в масляную 

полость, что в свою очередь может привести к недопустимому повышению давления в системе 

суфлирования, интенсивному насыщению масла водяными парами, вспениванию, окислению 

масла и т.д. 

Температура воздуха, поступающего в масляную полость не должна превышать 

предельно-допустимое значение по характеристикам термоокислительной стабильности масла. 

Температуру стенок, омываемых маслом, по тем же причинам ограничивают до 240-300 oC  [4]. 

Различают 3 типа схем наддува уплотнений масляных полостей и охлаждения опор ГТД.
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Тип 1: Наддув уплотнений воздухом из полости двигателя, в которой расположена опора 

Данная схема позволяет надувать уплотнения опор, находящихся в относительно 

холодной зоне, но имеющих давление достаточное для герметизации масляных полостей при 

используемом типе уплотнений на всех режимах работы двигателя. Главным преимуществом 

такой схемы является отсутствие необходимости в трубопроводных коммуникациях, 

обеспечивающих подвод воздуха.  

Примеры: средняя опора ТРДД Д-30КУ, средняя опора ТРДД НК-86 и др. 

Ниже представлены некоторые мероприятия, позволяющие реализовать данную схему в 

случаях, когда параметры воздуха в окружающей опору полости являются недопустимыми. 

Опора, расположенная под камерой сгорания двигателя НК-12 надувается воздухом из-за 

компрессора. Это было возможно осуществить благодаря относительно низким значениям 

температуры воздуха. Но давление воздуха, поступающего в масляную полость, превышало 

допустимое значение. Уменьшение давления было осуществлено суфлированием предмасляной 

полости, которая является также полостью разгрузки РУП. Данное решение не является 

привлекательным для современных двигателей из-за выброса «дорогого» воздуха в атмосферу. 

На сверхзвуковых режимах работы двигателя НК-25 за компрессором СД достигается 

существенное значение температуры воздуха, а рядом расположенные со средней опорой 

компрессора (рис. 3) вращающиеся диски интенсифицируют процесс теплоотдачи от воздуха к 

стенкам масляной полости.  В этом случае уменьшение переноса тепла от воздуха к стенкам 

было достигнуто установкой теплозащитных кожухов из листового материала. 

 

Рис. 3. Наддув уплотнений масляной полости средней опоры двигателя НК-25 

Тип 2: Подвод воздуха в предмасляную полость с необходимыми параметрами для 

наддува уплотнений и охлаждения опор 

Воздух для наддува уплотнений и охлаждения опор с необходимыми параметрами 

отбирается от соответствующей ступени компрессора. Схема типа 2 может использоваться, как 

для «холодных», так и для «горячих» опор при условии, что давление в предмасленой полости 
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обеспечивается больше давления в масляной полости и полостях граничащих с полостью 

наддува. Изменение параметров воздуха возможно путем его дросселирования, охлаждения, а 

так же переключением ступеней. 

На двигателе GE90 (рис. 4) реализован вариант такой схемы на наддуве уплотнений 

масляной полости передней опоры. 

 

 

Рис. 4. Наддув уплотнений масляной полости передней опоры двигателя GE90 

Переключение ступеней отбора воздуха для наддува уплотнений было реализовано на 

ТРДДФ АЛ-31Ф. В зависимости от режима работы двигателя клапан переключает отборы из-за 

второго контура (в районе 5-ой ступени компрессора ВД) и из-за 7-ой ступени компрессора ВД. 

На партии двигателей ПС-90А и ПС-90А1 (более 30 двигателей по состоянию на март 

2009г.)  для охлаждения опоры турбины ВД используется воздух «подходящей» по уровню 

давления промежуточной ступени компрессора ВД с последующим его дросселированием и 

охлаждением в воздухо-воздушном теплообменнике ВВТ-90 (рис. 5) [5]. Теплообменник был 

разработан на предприятии ООО «Анод-ТЦ». 

 

Рис. 5. ВВТ-90 
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Тип 3: Подвод воздуха в предмасляную полость с необходимыми параметрами (давление, 

температура) и организация буферной полости между предмасляной пололостью и  полостью 

двигателя 

Схема 3-го типа аналогична по способу подвода воздуха схеме 2-го типа, за одним 

исключением – между предмасляной  полостью (полостью наддува) и граничащей с ней 

полостью двигателя организована буферная полость. В этой полости, которою еще называют 

дренажной, создается пониженное давление путем ее сообщения с атмосферой, наружным 

контуром или же местом в тракте двигателя с относительно низким давлением (за турбиной 

низкого давления). Данная схема применяется в тех случаях, когда давление воздуха, 

подводимого для наддува уплотнений, меньше давления в граничащей полости двигателя, а 

подвод воздуха более высокого давления неосуществим из-за повышенных температур. 

Примером применения такой схемы является наддув уплотнений опор турбин двигателя 

GE90 воздухом, отбираемым за первой ступенью компрессора ВД. Для избегания попадания в 

предмасляную полость воздуха, подводимого для охлаждения и герметизации турбины, была 

организована буферная полость. Воздух от трех систем (наддува уплотнений масляных 

полостей опоры, герметизации и охлаждения турбины НД и системы разгрузки РУП) через 

лабиринтные уплотнения просачивается в данную полость и сбрасывается за турбину НД. 

Таким образом, было уменьшено до минимума взаимное влияние рассматриваемых систем друг 

на друга. 

Такой тип схемы  очень часто используется при расположении опоры между 

компрессором и турбиной ВД (Олимп-593, JT9D  и др.), в зоне высоких температур и давлений. 

1.1.3 Разгрузка РУП 

Разность осевых сил, действующих на компрессор и турбину, воспринимается РУП. 

Нагрузка, действующая на радиально-упорный подшипник должна быть в пределах 5-30кН [6]. 

В случае, если усилие превышает допустимое значение, то одним из путей по ее уменьшению 

является введение разгрузочных полостей, ограниченных уплотнениями. Разгрузочные полости 

могут разделяться по следующим особенностям: 

 Расположение полости разгрузки: 

 в компрессоре; 

 в турбине. 

 Способы создания требуемого давления в полости разгрузки: 

 подвод воздуха в полость; 

 суфлирование воздуха из полости. 

Примером расположения разгрузочной полости за компрессором ВД является двигатель 

Р11Ф2-300. Для уменьшения осевого усилия, действующего на РУП, воздух из полости 

стравливается в атмосферу. 

ТРДД GE90 является примером расположения разгрузочной полости за турбиной НД, в 

которую надувается воздух из-за четвертой ступени компрессора ВД. 

Нагрузку, действующую на РУП, не уменьшают до нуля. Причиной этого является 

возможность возникновения  отрицательного направления вектора усилия на подшипник. Это 

значительно уменьшает его ресурс и усложняет крепление в опоре. 
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1.1.4 Наддув трактовых уплотнений турбины НД 

Турбина НД практически не требует охлаждения. Наиболее важной задачей является 

наддув трактовых уплотнений для исключения утечек газа во внутренние полости 

двигателя. Для этих целей используется воздух различного давления. По способу его подвода 

используются следующие схемы: 

 Использования воздуха от системы охлаждения турбины с подходящим давлением; 

 Подвод воздуха от соответствующей ступени компрессора; 

 Использование утечек от других систем. 

Схема использования воздуха от системы охлаждения турбины с подходящим давлением 

и подвод воздуха от соответствующей ступени компрессора применяются чаще всего для 

наддува трактовых уплотнений перед турбиной НД, где газ имеет большее давление. Наддув 

трактовых уплотнений за турбиной НД обычно осуществляется воздухом утечек от других 

систем (системы наддува уплотнений, системы охлаждения турбины НД и др.). 

На двигателе GE90 наддув трактовых уплотнений перед турбиной НД происходит 

воздухом, отбираемым за 4-ой ступенью компрессора НД, а наддув трактовых уплотнений 

турбины НД, в свою очередь, воздухом утечек через лабиринтные уплотнения от системы 

наддува трактового уплотнения перед ТНД,  системы наддува уплотнений масляных полостей и 

системы разгрузки РУП. 

Подвод воздуха, отобранного перед компрессором ВД для наддува трактового уплотнения 

и охлаждения турбины НД двигателя НК-93, показан на рис. 6. 

 

Рис.6. Система герметизации и охлаждения турбины НД ТВВД НК-93 

 На втекание трактового газа во внутренние полости турбины влияют следующие 

факторы: 

- Насосный эффект ротора: центробежные силы в пограничном слое на поверхности диска 

выталкивают газ в полости наружу. Если этот радиальный массовый расход больше, чем 

массовый расход наддувочного воздуха, то оставшаяся разница компенсируется за счет 
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втекания горячих газов из тракта. Радиальный градиент давления вынуждает горячий газ идти 

вниз вдоль стенок статора. Затем он циркулирует в полости.  

- Давление в тракте: втекание вызвано окружным распределением давления в тракте 

двигателя. Взаимодействие лопаток соплового аппарата и вращающихся лопаток порождает 

районы локального высокого давления, где статическое давление горячего газа превышает  

давление в полости (рис.7). Горячий газ нагнетается в полость диска в этих зонах высокого 

давления. 

Как показывают большинство исследований наибольшее влияние на втекание горячего 

газа оказывает асимметрия давления в тракте за сопловым аппаратом. 

     

Рис. 7. Втекание газа из-за асимметрии давления 

1.1.5 Система управления радиальными зазорами 

Топливная экономичность двигателя тесно связана с совершенством составляющих его 

узлов. На КПД компрессора и турбины весьма существенное влияние оказывают значения 

радиальных зазоров между элементами ротора и статора. Зазоры назначают таким образом, 

чтобы исключить соприкосновение неподвижных и подвижных деталей ГТД и уменьшить до 

минимума врезание гребешков уплотнений в срабатываемые покрытия. При работе на 

крейсерском режиме турбокомпрессор имеет не оптимальные величины радиальных зазоров, 

поэтому проблема минимизации зазоров на этом режиме является актуальной. 

Из системы управления радиальными зазорами можно выделить следующие виды: 

 Системы воздействия на статор. 

Большинство двигателей, имеющих системы управления радиальными зазорами, 

применяют системы, воздействующие на температурное состояние статорных деталей путем 

управлением количеством воздуха, используемого для их обдува. Такие системы нашли свое 

применение в компрессоре ВД (ТРДД ПС-90 и др.), турбине ВД (ТРДД GE90, ТРДД ПС-90 и 

др.), но наибольшие успехи достигнуты в турбинах низкого давления (ТРДД GE90, ТРДД ПС-

90, CFM-56 и др.) 

 Системы воздействия на ротор. 
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Расчетный анализ конструкций компрессоров показывает, что принудительный обдув 

полотен дисков малым расходом воздуха ( 2% ) позволяет существенно сблизить темпы  

прогрева ротора и статора [7]. На серийных двигателях CF6-80 и PW4000 реализован способ 

обдува дисков роторов воздухом. 

 Способы управления: 

 активные системы управления радиальными зазорами; 

 пассивные системы управления радиальными зазорами. 

 Законы управления:  

 двухпозиционный; 

 управления расходом воздуха по заранее установленной модели; 

 использование системы обратной связи. 

1.1.6 ПОС двигателя 

Для предотвращения обледенения кока, входного направляющего аппарата и приемников 

температур и давления отбирается воздух от промежуточных ступеней или за компрессором 

ВД. 

Двигатели, имеющие ВНА, требуют его обогрева на высотных режимах работы для 

защиты от обледенения. «Горячий» воздух, проходящий через пустотелые ВНА, далее обычно 

используется для обогрева кока. Примерами такого исполнения могут служить двигатели 

SPEY25, Д-30КУ, АЛ-31Ф, НК-86 и др. 

Для обогрева кока двигателей, которые не имеют ВНА из-за требования соблюдения 

уровня шума, воздух проходит через внутренние полости двигателя (Д-36, ПС-90 и др.). 

На некоторых двигателях (АЛ-31Ф, ПС-90 и др.) присутствует переключение ступеней 

отбора воздуха для нужд ПОС в зависимости от режима работы. 

1.1.7 Самолетные нужды 

Воздух для нужд самолета подводится обычно для наддува кабины самолета, 

противообледенительной системы самолета и др. 

 



15 

 

1.2 Рекомендации по выбору перепадов давления и расходов воздуха, 

требуемых для функционирования воздушных систем 

Геометрические параметры элементов системы (уплотнения, отверстия и др.) выбираются 

из условий необходимых перепадов давления π, потребные значения которых, сформулированы 

на основе опыта проектирования ОКБ, приводятся ниже в виде рекомендаций: 

1) Для лопаток и дисков охлаждаемых турбин  для конвективного и плѐночного 

охлаждения 

ст

упень 
)выхода(газ

p

ух)входа(возд
p

. конв  

)выхода(газ
p

ух)входа(возд
p

. плёноч  
p в сечении отбора 

(воздух) 

1СА 1,8…1,9 1,025…1,035 pк из камеры сгорания 

1РК 1,5…1,7 1,1…1,15 pк из камеры сгорания 

через подкручивающую 

решѐтку 

2СА 1,4…1,5 - pотбора=0,4pк 

2РК 1,3…1,4 - pотбора=0,4pк через 

подкручивающую 

решѐтку 

 Остальные решѐтки выполняются неохлаждаемыми. Охлаждаются только елочные 

хвостовики рабочих лопаток продувом воздуха через зазоры. 

 Для сравнительного анализа результатов расчѐта систем охлаждения лопаток турбины 

приводятся относительные расходы охладителя qохл [%] на решѐтках лопаток турбин при 

T
*
Г=1550-1600К: 

1СА – 3,5…4,5% без учѐта 3% на плѐночное охлаждение; 

1РК – 3…3,5%; 

2СА - ≈ 2%; 

2РК – 1,5%. 

2) Наддув уплотнений предмасляных полостей опор роторов для исключения 

выхода масла из масляной полости: 

для транспортной авиации 

 ∆p=pвоздуха – pмасл. полости =0,1…0,5атм. 

где  ∆p=0,1атм – крейсерский режим (H=11км, Мп=0,8) 

 ∆p=0,5атм – взлѐтный режим 

для военной авиации 

 ∆p=0,05атм – крейсерский режим (H=20км, Мп=2,2) 

 ∆p=1,0атм – взлѐтный режим 

 Перепад давления на ТКУ ∆p=1…2атм (менее 0,5 не делают). 

 Расход воздуха на наддув уплотнений GВ упл. (на одно уплотнение): 

 лабиринтных – 15…20г/с 

 контактных - ≈ 2г/с 

3) Разгрузка РУП  pотбора=0,2pК. Для ротора НД отбор производится за КНД или КСД. 
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2 АЛГОРИТМ РАСЧЁТА 

Алгоритм, представленный на рис. 8, позволяет определить значения параметров рабочего 

тела по каналам воздушной системы с учѐтом теплообмена воздуха с элементами двигателя и 

величин рабочих радиальных зазоров уплотнений. Представленный алгоритм является 

упрощѐнным, поскольку он не включает итерационные циклы, связанные с уточнением 

значений параметров рабочего тела в тракте из термодинамического и газодинамического 

расчѐтов. Поэтому данный расчѐт имеет только 2 цикла итераций. Первый цикл связан с 

уточнением температур стенок каналов, а второй с уточнением величин радиальных зазоров 

лабиринтных уплотнений. 

 

Рис. 8. Алгоритм расчѐта системы внутренних воздушных потоков 

Расчѐт ведѐтся в следующей последовательности. 

1. Термодинамический расчет. Обеспечивает получение средних параметров на 

входе и выходе из узлов двигателя. Для проведения задаются расходами воздуха на отборы и 

КПД узлов. 
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2. Газодинамический расчет. Определяются температуры, давления и коэффициенты 

теплоотдачи в тракте двигателя. Отборы и потери воздуха из тракта регламентированы 

предыдущим расчетом. 

3. Гидравлический расчѐт. Проводится с использованием построенного графа 

системы, известной геометрии каналов, параметров рабочего тела на входе и выходе из 

системы, а также температур стенок каналов. Результатом расчета являются давления и 

параметры конвекции ( и 
*

BT ) на всех деталях модели двигателя. 

4. Тепловой расчет в ANSYS. Результатом расчета являются температурные поля на 

конструкции. Проводится сравнение полученной средней температуры стенок каналов с 

заданными значениями. В случае не достижения заданной точности, расчет повторяется с 

пункта 3, где средние температуры стенок задаются в новом приближении. Критерий 

сходимости по средней температуре на компоненте – разница с предыдущим расчетом менее 

одного градуса °С. 

5. Структурный расчет. Определяются значения изменения радиальных зазоров в 

уплотнениях и в проточной части двигателя Полученные величины радиальных зазоров в 

уплотнениях сравниваются с заданными конструктивно. В случае не достижения заданной 

точности расчет повторяется с пункта 3, где задаются уточненные значения радиальных 

зазоров. Достигнутая сходимость по зазорам должна быть не менее 5%. 
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3 ГИДРАВЛИЧЕСКИЙ РАСЧЁТ ВОЗДУШНОЙ СИСТЕМЫ 

Для проведения гидравлического расчѐта необходимо на первом этапе изучить 

воздушную систему и построить по ней граф [8, 9], ветви которого соответствуют воздушным 

каналам, а узлы - местам соединения каналов в единую систему (рис. 9). 

 

Рис. 9. Одномерное представление системы наддува уплотнения масляной полости 

В работе Мюллера [10] система внутреннего воздухоснабжения представляется в виде 

разветвленной сети конечных элементов. В качестве основных уравнений при этом 

используется уравнение неразрывности (3.1), уравнение энергии (3.2) и уравнение сохранения 

моментов движения в форме (3.3): 
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(3.2) 

 

 1 2 1 2, , , , 0.mf p p T T G   (3.3) 

Для решения системы, составленной из уравнений (2.1)-(2.3), используется 

модифицированный метод Ньютона (метод касательных). Каждый элемент при таком подходе 

характеризуется коэффициентом потери давления и уравнением потока.  

В [Ошибка! Источник ссылки не найден.] для описания течения воздуха в 

разветвленных сетях используется система алгебраических уравнений:  

0i jG   , (3.4) 
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(3.5) 

Применение теории графов для расчета параметров разветвленной гидравлической сети 

подробно описано в [12] и в монографии [13]. На рис. 10 показан граф СВВП турбины 

двигателя НК-93 (ОАО «СНТК им. Н.Д. Кузнецова).  

 
Рис. 10. Одномерное представление СВВП двигателя НК-93 (фрагмент)  

Система уравнений, описывающих распределение параметров в гидравлической цепи, в 

матричной форме имеет вид: 

  Ax=Q, (3.6)  

Bh=0, 

h+H=SXx, 

где А – матрица соединений для линейно-независимых узлов; x – вектор расходов на 

ветвях графа; Q – вектор расходов в узлах; B – матрица контуров; h – вектор-столбец напоров 

на ветвях графа; H – вектор активных напоров; S – диагональная матрица, составленная из 

величин гидравлических сопротивлений; X – диагональная матрица, составленная из величин 

расходов. 
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В работе программа ХПИ использует два основных компонента: 

– GeneralWindow.exe — GUI-модуль программы, используется для создания файла 

конфигурации решателя name.ini; 

– ANSYS_Solu.exe — непосредственно решатель. 

Указанные файлы программы должны находиться в одном каталоге. GUI-модуль 

программы имеет вид, показанный на рис. 11. Для работы программы необходимо указать 4 

файла: 

1 Файл описания геометрии каналов (рис. 13); 

2 Файл режимов работы двигателя (рис. 22); 

3 Файл температуры стенок каналов (рис. 23); 

4 Файл компонентов (рис. 24). 

Так же необходимо ввести название файла-макроса для ANSYS и название файла 

результатов расчѐта. 

 

 
Рис. 11. GUI-модуль программы ХПИ 

Следует отметить, что файл компонентов не является обязательным файлом. Данный файл 

необходим для создания файла-макроса приложения конвективной нагрузки к элементам 

двигателя. Его следует создавать и указывать только в случае, если на основе полученных 

данных будет проводиться тепловой анализ в ANSYS. 

Все перечисленные файлы имеют текстовый формат разделителей целых и дробных 

частей – точки и разделителей элементов списка - запятые. Для настройки формата 

разделителей необходимо следовать по пути: Панель управления – Язык и региональные 

стандарты (рис. 12а). Далее во вкладке региональных параметров заходим в настройки и 

редактируем соответствующие поля (рис. 12б). 
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 а) б) 

Рис. 12. Настройка разделителей целых и дробных частей, а так же разделителей 

элементов списка 

Для создания файлов исходных данных используется файл электронных таблиц data.xls 

(автор — Сухов М.В.). Более подробно процесс формирования исходных данных рассмотрен в 

следующем разделе. 

3.1 Задание геометрических параметров 

Для определения геометрических параметров система разбивается на геометрически 

однородные участки. Параметры участков определяются на первом листе xls-файла (рис. 13). 

Этот лист состоит из двух основных таблиц: верхней и нижней. В верхней определяются общие 

параметры системы (число элементов, число свободных узлов и т.д.) и параметры работы 

вычислительного аппарата системы. Вторая таблица содержит данные непосредственно о 

каналах системы и их взаимосвязи. 

 

Рис. 13. Лист исходных данных (вкладка геометрия).  

Обозначение параметров работы вычислительного аппарата программы показано в 

табл. 1. 
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Табл. 1. Параметры, определяющие работу вычислительного аппарата программы 

Обозначение на листе Параметр 

NMAX 

общее количество ветвей (каналов) в системе охлаждения; 

максимально возможное количество каналов, предусмотренное 

программой, равно 300 

NMР 

количество внешних узлов системы охлаждения, то есть таких 

узлов, через которые подается охлаждающий воздух в систему 

охлаждения, или из которых происходит выход воздуха из системы в 

проточную часть; в этих узлах известны значения давления и температуры 

подаваемого воздуха или горячего газа в соответствующих местах 

проточной части турбины 

E 
относительная погрешность в определении расходов воздуха в 

каналах, допускаемая при учете влияния подогрева воздуха 

PECH 

признак внутренней печати, которая предусмотрена в программе, 

кроме основной печати исходных данных и результатов расчета; если 

задать PECH = 0, то внутренняя печать не будет включена, а если задать 

PECH = 1 и одновременно задать Е5 = N, где N – номер приближения по 

учету влияния подогрева воздуха, то получим распечатку дополнительных 

данных, вычисленных на указанном приближении N 

ALO 

коэффициент, учитывающий снижение интенсивности теплоотдачи 

в каналах с ламинарным режимом течения при одностороннем 

теплообмене. Рекомендуемое значение – 0.65 

ATU 

коэффициент, учитывающий снижение интенсивности теплоотдачи 

в канал с турбулентным режимом течения при одностороннем 

теплообмене. Рекомендуемое значение – 0.8 

ИТЕР.Q 

предельно допустимое количество итераций в уточнении расходов 

воздуха при удовлетворении второму закону Кирхгофа для замкнутых 

контуров; если за указанное количество итераций по расходу Q процесс 

не сходится, то рассматриваемая система плохо обусловлена и заданная 

точность расчета не может быть достигнута 

∆G 

относительная погрешность в определении расхода воздуха в 

каналах, допускаемая при решении системы уравнений для замкнутых 

контуров в соответствии со вторым законом Кирхгофа; при достижении 

заданной точности итераций по уточнению расходов в каналах 

заканчиваются и переходим к следующему приближению по учету 

влияния подогрева воздуха в каналах 

ИТЕР.Т 

максимально допустимое количество итераций по учету влияния 

подогрева воздуха в каналах; если за указанное количество итераций по 

температуре заданная точность не достигается, то расчет прекращается и 

выводится на печать результаты, полученные в последнем приближении 

PR 
число Прандтля по средним параметрам охлаждающего воздуха в 

каналах (для воздуха задаѐтся 0,72) 
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Продолжение табл. 1. 

E0 

предельный расход воздуха в каналах для уточнения влияния 

подогрева воздуха; если в некоторых каналах расход воздуха меньше 

предельной величины Е0, то для уменьшения количества итераций по 

температуре проверка точности в этих каналах не производится 

E4 

признак учета центробежных сил, если Е4 =1, то расчет 

производится с учетом центробежных сил, если Е4= 0 – расчет без учета 

центробежных сил 

E5 

количество интервалов, на которые разбивается участок на боковой 

поверхности диска при определении значения коэффициента закрутки 

потока вдоль радиуса диска 

Е1, Е2, Е2, Е7, Е8 пока свободны и в исходных данных не задаются 

В табл. 2 представлены типы каналов, рассчитываемые в программе. 

Табл. 2. Типы каналов системы 

Значение параметра  

LP1 
Тип канала 

LP1=1 Круглый канал  

LP1=2 Плоский канал 

LP1=3 Кольцевой канал 

LP1=5 Плоский канал со столбиками турбулизаторами 

LP1=7 

Плоская поверхность, обдуваемая рядом круглых струй 

через отверстия в расположенной напротив перфорированной 

пластине 

LP1=8 
Боковая поверхность вращающегося диска, обдуваемая 

воздухом 

LP1=9 

Система отверстий при выдуве через них воздуха в 

плоский канал со сносящим автономным потокам и на 

обдуваемом участке плоского канала 

LP1=10 
Участок струйного обдува в плоском канале с 

автономным сносящим потоком 

LP1=11 Подкручивающая решетка 

LP1=12 Каналы, расположенные в охлаждаемой лопатке 

LP1=17 Лабиринтное уплотнение 
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Исходные данные, характеризующие каналы воздушных систем, включают максимально 

30 пунктов. В зависимости от типа канала  заполняются те или иные из 30 пунктов.  

3.1.1 Описание параметров, задаваемых в каналах 

Ниже представлены параметры, которые соответствуют всем каналам.  

I – номер ветви; 

IN – номер начального узла; 

JN – номер конечного узла;  

Q – расход воздуха, задаваемый в входных каналах системы охлаждения, если величина 

расхода не задается, то Q=0; 

Если задать PL10=9, то для любого типа канала не вычисляются коэффициенты 

гидравлического сопротивления СУМ, а задаются в исходных данных в массиве PL2: при этом 

геометрические размеры канала все равно задаются в исходных данных для вычисления 

значений скоростей и коэффициентов теплоотдачи. 

TC – тип компоненты для написания макроса приложения конвективной нагрузки (TC=0 – 

компонент в ANSYS состоит из узлов; TC=1 – компонент состоит из элементов (в данном 

случае LINK34); TC=2 – компонент состоит из поверхностей (для 3D моделей)). 

КРУГЛЫЙ КАНАЛ – LP1=1 

PL2 – расстояние до экрана на входе в канал (см. рис. 14); 

 
Рис. 14. Экраны на входе в канал и на выходе из канала 

PL3 – угол поворота в канале (см. рис. 15); 

 
Рис. 15. Угол поворота в канале 

PL4 – величина местного сужения в виде отношения площади проходного сечения в месте 

сужения к площади проходного сечения основного канала (см. рис. 16); 
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Рис. 16. Сужение в канале 

PL5 – признак вращения канала: 

 PL5=0 – канал не вращается; 

 PL5=1 – во вращающейся  канал воздух поступает из неподвижной полости в корпусе и 

входит в такую же неподвижную полость; 

 PL5=2 – воздух поступает из неподвижной полости в корпусе и выходит в полость 

вращающего ротора; 

 PL5=3 – воздух поступает из вращающейся полости ротора и выходит в неподвижную 

полость корпуса; 

 PL5=4 – воздух поступает из вращающейся полости ротора и выходит в вращающуюся 

полость. 

PL6 – расстояние до экрана на выходе из канала (см. рис. 14); 

DI – диаметр канала; 

AL – длина канала; 

ZI – количество каналов; 

DR – коэффициент для вращающихся вертикальных или наклонных каналов, 

учитывающий степень изменения температуры в канале под воздействием центробежного 

эффекта (К=0-1); 

F1 – отношение площади проходного сечения канала к площади на входе в канал 

(рис. 17); 

    

 а) б) 

Рис. 17. Величины F0, F1 и F2 

F2 – отношение площади проходного сечения к площади на выходе из канала; 
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Параметры F1 и F2 используют для учѐта гидравлических потерь на входе в канал и на 

выходе из него соответственно. Параметр F1 определяется как 
F0

F1=
F1

, а F2 как 
F0

F2 =
F2

. 

При значениях F1 или F2 >1 (рис. 17а) величины принимают равными единице, в другом 

случае (рис. 17б) они рассчитываются. 

Для учета влияния ц/б сил задаются: RBX – радиус входа в канал; 

 RBV – радиус выхода из канала; 

RKR – радиусы скругления кромок на входе и выходе из канала; 

Для вращающихся каналов задается: NB – номер вала; 

PL7 – показатель степени p в приближенной зависимости распределения температурного 

напора tст-tв=Kx
p
 по длине канала; 

PL10=1 – для канала в ободе диска, расположенного напротив подкручивающей решетки. 

ПЛОСКИЙ КАНАЛ – LP1=2 

PL2 – расстояние до экрана на входе в канал; 

PL3 – угол поворота в канале; 

PL4 – величина местного сужения в виде отношения площади проходного сечения в месте 

сужения к площади проходного сечения основного канала; 

PL5 – признак вращения канала: 

 PL5=0 – канал не вращается; 

 PL5=1 – во вращающейся  канал воздух поступает из неподвижной полости в корпусе и 

входит в такую же неподвижную полость; 

 PL5=2 – воздух поступает из неподвижной полости в корпусе и выходит в полость 

вращающего ротора; 

 PL5=3 – воздух поступает из вращающейся полости ротора и выходит в неподвижную 

полость корпуса; 

 PL5=4 – воздух поступает из вращающейся полости ротора и выходит в вращающуюся 

полость. 

PL6 – расстояние до экрана на выходе из канала; 

DI – ширина плоского канала; 

AH – высота канала; 

AL – длина канала; 

ZI – количество каналов; 

DR – коэффициент для вращающихся вертикальных или наклонных каналов, 

учитывающий степень изменения температуры в канале под воздействием центробежного 

эффекта (К=0-1); 

F1 – отношение площади проходного сечения канала к площади на входе в канал (при 

F1≥1, принимаем F1=1); 

F2 – отношение площади проходного сечения к площади на выходе из канала (при F2≥1, 

принимаем F2=1); 

D – Признак подогрева в каналах: 

 D=9 – односторонний подогрев; 

 D=0 – двусторонний подогрев; 
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Для учета влияния ц/б сил задаются: RBX – радиус входа в канал; 

 RBV – радиус выхода из канала; 

RKR – радиусы скругления кромок на входе и выходе из канала; 

Для вращающихся каналов задается: NB – номер вала; 

PL7 – показатель степени p в приближенной зависимости распределения температурного 

напора tст-tв=Kx
p
 по длине канала; 

PL9: 

 PL9=0 – обычный плоский канал; 

 PL9=1 – плоский канал в охлаждаемой лопатки после струйного обдува входной кромки; 

PL10=1 – для канала в ободе диска, расположенного напротив подкручивающей решетки. 

КОЛЬЦЕВОЙ КАНАЛ – LP1=3 

PL2 – расстояние до экрана на входе в канал; 

PL3 – угол поворота в канале; 

PL4 – величина местного сужения в виде отношения площади проходного сечения в месте 

сужения к площади проходного сечения основного канала; 

PL5 – признак вращения канала: 

 PL5=0 – канал не вращается; 

 PL5=1 – во вращающейся  канал воздух поступает из неподвижной полости в корпусе и 

входит в такую же неподвижную полость; 

 PL5=2 – воздух поступает из неподвижной полости в корпусе и выходит в полость 

вращающего ротора; 

 PL5=3 – воздух поступает из вращающейся полости ротора и выходит в неподвижную 

полость корпуса; 

 PL5=4 – воздух поступает из вращающейся полости ротора и выходит в вращающуюся 

полость. 

PL6 – расстояние до экрана на выходе из канала; 

DI – средний диаметр (см. рис. 18); 

 
Рис. 18. Кольцевой канал 

AH – высота канала (см. рис. 18); 

AL – длина канала (см. рис. 18); 

ZI – количество каналов; для данного канала ZI принимается больше 0 (например 1); 
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DR – коэффициент для вращающихся вертикальных или наклонных каналов, 

учитывающий степень изменения температуры в канале под воздействием центробежного 

эффекта (К=0-1); 

F1 – отношение площади проходного сечения канала к площади на входе в канал (при 

F1≥1, принимаем F1=1); 

 F2 – отношение площади проходного сечения к площади на выходе из канала (при F2≥1, 

принимаем F2=1); 

D – Признак подогрева в каналах: 

 D=9 – односторонний подогрев; 

 D=0 – двусторонний подогрев; 

Для учета влияния ц/б сил задаются:  RBX – радиус входа в канал; 

 RBV – радиус выхода из канала; 

RKR – радиусы скругления кромок на входе и выходе из канала; 

Для вращающихся каналов задается: NB – номер вала; 

PL7 – показатель степени p в приближенной зависимости распределения температурного 

напора tст-tв=Kx
p
 по длине канала; 

PL9: 

 PL9=0 – для обычного кольцевого канала; 

 PL9=1 – для кольцевого канала, расположенного после системы отверстий в торцевой 

стенке; 

PL10=1 – для канала в ободе диска, расположенного напротив подкручивающей решетки. 

УПЛОТНЕНИЕ – LP1=17 

PL3 – угол наклона гребешков на входе; 

PL4 – угол наклона гребешков на выходе; 

DI – средний диаметр; 

AH – высота камеры уплотнения; 

AL – длина уплотнения; 

Z1 – количество уплотнительных усиков; 

Z2 – шаг уплотнения; 

DR – радиальный зазор; 

D – толщина кромки усика; 

AM – высота выступа уплотнения (для гладкого AM=0). 

 Приведенные выше параметры изображены на рис. 19. 

 
Рис. 19. Геометрические параметры лабиринтного уплотнения 
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ТЕЧЕНИЕ ВДОЛЬ ПОЛОТНА ВРАЩАЮЩЕГОСЯ ДИСКА – LP1=8 

AH – расстояние между диском и корпусом или между двумя дисками; 

ZI – количество каналов; для данного канала параметр принимается больше 0 (например 

1); 

DR – коэффициент для вращающихся вертикальных или наклонных каналов, 

учитывающий степень изменения температуры в канале под воздействием центробежного 

эффекта (К=0-1); 

F2 – среднее значение коэффициента закрутки потока (если мы хотим его не рассчитывать 

программно, а задать по имеющимся экспериментальным данным); 

D – тип течения вдоль диска: 

 D=1 – течение между диском и корпусом от центра к периферии; 

 D=2 – течение между диском и корпусом от периферии к центру; 

 D=3 – течение между двумя вращающимися дисками от центра к периферии; 

 D=4 – течение между двумя вращающимися дисками от периферии к центру; 

 D=5 – струйный обдув боковой поверхности диска; 

 D=6 – течение на боковой поверхности диска выше зоны струйного обдува; 

 При D=5, 6 дополнительно задаются: 

PL6 – радиус, на котором расположены отверстия струйного обдува; 

Z1 – количество отверстий струйного обдува; 

DR – диаметр отверстий струйного обдува. 

AM – коэффициент начальной закрутки. 

В качестве коэффициента начальной закрутки можно задавать только три значения: 0, 0.5, 

1. AM=1 – если воздух поступает в данный канал из вращающейся полости. AM=0 задаѐтся в 

случае, если воздух поступает в данный канал из полости корпуса. AM=0.5 занимает 

промежуточное положение. 

RBX – радиус на котором охладитель подводится  к полотну диска (см. рис. 20); 

RBV – радиус, на котором заканчивается течение вдоль полотна диска (см. рис. 20); 

NB – номер вала, на котором расположен диск; 

PL7 – показатель степени закона распределения температурного напора (от 1 до 4); 

PL8 – номер ветви, с которой начинается течение вдоль полотна диска (если все полотно 

диска представлено на гидравлической схеме в виде одной ветви, то PL8 равняется номеру этой 

ветви, а если полотно диска разбито на несколько участков, то для каждого из них PL8 задается 

равным номеру ветви, соответствующей первому участку в направлении течения); 

PL10=2 – к диску подводится воздух после подкручивающей решетки. 



30 

 

 
Рис. 20. Канал между стенкой статора и вращающимся диском 

Далее представлены описания специальных каналов, которые имеются в программе, но не 

используются для моделирования систем наддува уплотнений масляных полостей. 

ЗОНА СТРУЙНОГО ОБДУВА ВХОДНОЙ КРОМКИ ОХЛАЖДАЕМОЙ ЛОПАТКИ 

ЧЕРЕЗ СИСТЕМУ ОТВЕРСТИЙ, ВЫПОЛНЕННЫХ В ДЕФЛЕКТОРЕ – LP1=5 

PL3 – угол поворота потока; 

DI – диаметр отверстий, через которые осуществляется струйный обдув входной кромки; 

AH – высота дефлектора в зоне входной кромки; 

AL – длина внутренней поверхности оболочки лопатки, относящейся к входной кромке; 

Z1 – количество отверстий для струйного обдува в одной лопатке; 

F1 – отношение площади проходного сечения всех отверстий к площадям проходного 

сечения на входе в отверстия; 

F2 – отношение площади проходного сечения всех отверстий к площадям проходного 

сечения на выходе из отверстий; 

PL8 – количество лопаток в ступени; 

PL10: 

 PL10=0 – расчет теплообмена при струйном обдуве входной кромки лопатки из 

отверстий дефлектора выполняется по методике ИТТФ; 

 PL10=1 – по методике КАЗ; 

 При PL10=1 задается  

PL6 – расстояние от носика дефлектора до входной кромки. 

Примечание: при желании всю высоту охлаждаемой лопатки можно разбить на несколько 

участков и перечисленные выше характеристики задать отдельно для каждого участка. 

ПЛОСКИЕ КАНАЛЫ С ЦИЛИНДРИЧЕСКИМИ ТУРБУЛИЗАТОРАМИ – LP1=6 

DI – ширина канала по незагроможденному сечению; 

AH – высота канала; 

AL – длина канала в зоне расположения турбулизаторов; 

Z1 – количество каналов; 

Z2 – продольный шаг между турбулизаторами; 

DR – диаметр турбулизаторов; 
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F1, F2 – соотношение площадей; 

S – поперечный шаг между турбулизаторами; 

D – Признак подогрева в каналах: 

 D=9 – односторонний подогрев; 

 D=0 – двусторонний подогрев; 

PL9: 

 PL9=1 для шахматного расположения турбулизаторов; 

 PL9=2 для коридорного расположения турбулизаторов; 

PL10: 

 PL10=0 – для расчета коэффициентов гидравлического сопротивления и теплоотдачи по 

методике НЗЛ; 

 PL10=1 – для расчета по методики ЦИАМ. 

 

СТРУЙНЫЙ ОБДУВ ПОЛОК ЛОПАТОК ИЛИ ДРУГИХ ПЛОСКИХ ПОВЕРХНОСТЕЙ 

СИСТЕМОЙ МНОГОРЯДНЫХ СТРУЙ БЕЗ АВТОНОМНОГО СНОСЯЩЕГО ПОТОКА – 

LP1=7 

DI – ширина канала; 

AH – высота плоского канала между обдуваемой поверхностью и перфорированной 

пластиной; 

Z1 – количество отверстий в перфорированной пластине в одной лопатке (или в одном 

канале); 

DR – диаметр отверстий струйного обдува; 

S – шаг между отверстиями в перфорированной пластине; 

PL8 – количество лопаток (или параллельных каналов); 

PL9: 

 PL9=0 – при течении охладителя после струйного обдува в одном направлении; 

 PL9=1 – при растекании охладителя после струйного обдува в двух направлениях. 

 

СИСТЕМА ОТВЕРСТИЙ СТРУЙНОГО ОБДУВА ПОВЕРХНОСТИ ПРИ НАЛИЧИИ 

АВТОНОМНОГО СНОСЯЩЕГО ПОТОКА – LP1=9 

DI – диаметр отверстий; 

AL – толщина стенки, через которую выдувается воздух; 

Z1 – количество отверстий в одной лопатке; 

PL8 – количество лопаток в ступени или количество одинаковых параллельных каналов. 

УЧАСТОК ПЛОСКОГО КАНАЛА, ОБДУВАЕМОГО  

СИСТЕМОЙ СТРУЙ ПРИ НАЛИЧИИ АВТОНОМНОГО СНОСЯЩЕГО ПОТОКА – 

LP1=10 

DI – ширина канала; 

AH – высота канала, равная расстоянию от обдуваемой поверхности до перфорированной 

пластины; 
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AL – длина канала в зоне струйного обдува; 

Z1 – количество каналов в лопатке; 

PL8 – количество лопаток. 

ПОДКРУЧИВАЮЩАЯ СОПЛОВАЯ РЕШЕТКА – LP1=11 

PL3 – угол выхода из решетки (рис. 21); 

PL4 – коэффициент скорости для сопловой решетки; 

DI – ширина межлопаточного канала, равная шагу лопаток в решетке (рис. 21); 

AH – высота канала, равная высоте лопаток (рис. 21); 

AL – длина канала, равная полупериметру профиля лопаток; 

Z1 – количество лопаток в ступени; 

RBX=RBV – средний радиус решетки (рис. 21); 

NB – номер вала, к которому подводит воздух подкручивающая решетка. 

 
Рис. 21. Подкручивающая решѐтка 

КАНАЛЫ, РАСПОЛОЖЕННЫЕ В ОХЛАЖДАЮЩЕЙ ЛОПАТКЕ – LP1=12 

PL2 – расстояние до экрана на входе в канал; 

PL3 – угол поворота в канале; 

PL4 – величина местного сужения в виде отношения площади проходного сечения в месте 

сужения к площади проходного сечения основного канала; 

PL5 – признак вращения канала: 

 PL5=0 – канал не вращается; 

 PL5=1 – во вращающейся  канал воздух поступает из неподвижной полости в корпусе и 

входит в такую же неподвижную полость; 

 PL5=2 – воздух поступает из неподвижной полости в корпусе и выходит в полость 

вращающего ротора; 

 PL5=3 – воздух поступает из вращающейся полости ротора и выходит в неподвижную 

полость корпуса; 

 PL5=4 – воздух поступает из вращающейся полости ротора и выходит в вращающуюся 

полость. 

PL6 – расстояние до экрана на выходе из канала; 

DI – ширина канала (или его диаметр); 

AH – высота канала; 

AL – длина канала; 

Z1 – количество параллельных каналов в одной лопатке; 
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DR – коэффициент для вращающихся вертикальных или наклонных каналов, 

учитывающий степень изменения температуры в канале под воздействием центробежного 

эффекта (К=0-1); 

F1 – отношение площади проходного сечения канала к площади на входе в канал (при 

F1≥1, принимаем F1=1); 

F2 – отношение площади проходного сечения к площади на выходе из канала (при F2≥1, 

принимаем F2=1); 

D – Признак подогрева в каналах: 

 D=9 – односторонний подогрев; 

 D=0 – двусторонний подогрев; 

Для учета влияния ц/б сил задаются: RBX – радиус входа в канал; 

 RBV – радиус выхода из канала; 

RKR – радиусы скругления кромок на входе и выходе из канала; 

Для вращающихся каналов задается: NB – номер вала; 

PL7 – показатель степени p в приближенной зависимости распределения температурного 

напора tст-tв=Kx
p
 по длине канала; 

PL8 – количество лопаток в ступени; 

PL9: 

 PL9=0 – обычный плоский канал; 

 PL9=1 – плоский канал в охлаждаемой лопатки после струйного обдува входной кромки; 

PL10=1 – для канала в ободе диска, расположенного напротив подкручивающей решетки. 

 

Все геометрические размеры каналов задаются в миллиметрах. По перечисленным выше 

исходным данным в программе вычисляются площади проходных сечений каналов, периметры 

и поверхности теплосъема, гидравлические и тепловые характерные размеры, коэффициенты 

гидравлического сопротивления с учетом зависимости физических параметров воздуха по 

тракту системы охлаждения, расход воздуха по каналам с учетом влияния его подогрева. 

Следует отметить, что не всегда существует возможность точно определить значение 

параметра. На практике такие величины на первом этапе выбирают по усмотрению инженера-

расчѐтчика и далее проводят верификацию на основе экспериментальных данных. 

3.2 Задание режима работы двигателя и граничных условий системы 

Вкладка задания режима работы двигателя показана на рис. 22. В таблице перечислены 

свободные узлы системы, в которых известны газодинамические параметры (давление и 

температура). Давления в узлах задаются в кг/см
2
, температуры — в °С. В зависимости от 

конфигурации отбора или сброса  воздуха,   в   качестве   граничного   давления   может   

указываться статическое или полное давление. В качестве всех температур задаются полные 

температуры. В нижней части таблицы указываются обороты роторов в об/мин. 
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Рис. 22. Параметры режима работы двигателя 

3.3 Задание температуры стенок каналов 

Последняя вкладка определяет подогрев потока в элементах системы. Для его задания 

необходимо указать среднюю температуру стенок каналов. Как правило, на этапе 

проектирования системы эти значения не известны. Поэтому задача должна решаться методом 

последовательных приближений. В первом приближении температуры задаются по данным 

прототипа или из опыта проектирования систем охлаждения. Для поверочных расчетов обычно 

одного приближения по температурам стенок каналов бывает достаточно. Если же целью 

расчета является точное определение параметров потока в цепи системы воздухоснабжения,  то 

число итераций  должно быть увеличено.  Общий вид таблицы температур стенок каналов 

показан на рис. 23. Таблица частично повторяет данные листа геометрии системы (первые 3 

столбца определяют соответственно номер элемента, начальный и конечный узлы). Как и в 

предыдущих случаях, все температуры задаются в °С. 

 
Рис. 23. Температуры стенок каналов 

3.4 Создание файла компонентов 

Для автоматического создания файла-макроса с тепловыми нагрузками для ANSYS 

необходимо создать текстовый файл, показанный на рис. 24. В данном файле необходимо 

ввести список названий компонентов модели в ANSYS. Каждое название должно 

соответствовать строчке канала. Ветвям, тепловая нагрузка от которых в дальнейшем не 

прикладывается к компонентам ANSYS, задавать имена не обязательно. 
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Рис. 24. Компоненты 

3.5 Результаты расчета СВВ 

После задания всех исходных данных и выполнения решения программа создает файл 

результатов расчета. Этот файл имеет текстовый формат с разделителями-запятыми (как и 

входные файлы программы) и расширение, как правило, *.csv. В первой таблице файла 

содержатся рассчитанные геометрические параметры элементов системы. В дальнейших 

расчетах они не участвуют и несут сугубо информативную нагрузку. Во второй таблице файла 

результатов содержится информация непосредственно о поведении воздушных потоков в 

элементах системы. 

Обозначение и расшифровка рассчитанных параметров воздушной системы представлены 

в табл. 3. 
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Табл. 3. Рассчитанные параметры воздушной системы 

Обозначение в 

файле результатов 
Расшифровка 

I 
Номер канала. Повторяет нумерацию из входного файла 

геометрии каналов 

IN Номер входного узла канала 

PN Давление во входном узле 

JN Номер выходного узла канала 

PN Давление в выходном узле канала 

PSR Среднее давление в канале 

TV Температура воздуха в канале 

W Скорость воздушного потока 

Q 

Расход воздуха через рассматриваемый элемент. Если 

расход имеет отрицательное значение, то течение происходит 

из выходного узла во входной 

RE Число Рейнольдса 

SISU Гидравлическое сопротивление канала 

A Коэффициент теплоотдачи стенки канала 

TN Температура во входном узле 

TK Температура в выходном узле 
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4 РЕКОМЕНДАЦИИ ПО ПРОВЕДЕНИЮ ТЕПЛОВОГО РАСЧЁТА 

Как и для любой конечно-элементной системы, весь процесс расчета можно условно 

поделить на несколько основных этапов: 

•   определение области рассматриваемой задачи (структурный расчет, тепловой расчет, 

расчет собственных форм колебаний, анализ гармонического отклика системы и другие); 

•   выбор типа расчета (стационарный, нестационарный); 

•   выбор типа конечных элементов; 

•   создание конечно-элементной сетки; 

•   создание моделей материалов; 

•   определение граничных условий и приложение нагрузок; 

•   непосредственно решение задачи; 

•   анализ результатов, принятие решения о выполнении поставленной задачи. 

Большинство из указанных этапов требуют индивидуального рассмотрения в зависимости 

от типа расчета, но некоторые из них (в частности, создание конечно-элементной сетки и 

моделей материалов) являются общими для любого анализа.  

Подробно методика проведения теплового расчѐта представлена в [14]. 

4.1 Создание конечно-элементной сетки 

Существует множество подходов к созданию конечно-элементной сетки. Она может быть 

создана как непосредственно в ANSYS на собственной, либо импортированной из любого 

2D/3D-пакета геометрии, так и в сторонних пакетах. Выбор способа создания сетки остается за 

пользователем и зависит от его навыков или предпочтений. 

При расчете теплового состояния таких массивных узлов двигателя как ротора или 

статора, как правило, используются 2-мерные осесимметричные модели. Понятно, что полное 

3-мерное моделирование таких сложных физических объектов связано с большими 

трудностями в процессе реализации и получении решения, и выигрыш в точности расчета не 

компенсирует затрат на проведение расчета. 

Ниже приведен общий подход к созданию конечно-элементной модели для теплового 

расчета: 

•   у   всех   осесимметричных   конечных   элементов   существует   ось симметрии. В 

ANSYS этой осью является ось OY глобальной декартовой системы координат (эта система не 

подлежит изменениям и обладает номером ноль, может быть активирована командой CSYS,0). 

Поэтому конечно-элементная модель должна быть расположена таким образом, чтобы ось 

вращения двигателя совпадала с осью OY; 

•   не стоит стремиться к тщательному совпадению сетки и геометрии модели. Точное 

моделирование мелких геометрических объектов (фаски, скругления, галтели) приводит в 

большей мере к увеличению времени расчета, а не к увеличению точности полученных 

результатов; 

•   при моделировании тонкостенных оболочек число элементов по толщине оболочки 

следует выбирать не менее трех-четырех; 

•  детали вращения моделируются осесимметричными элементами; в качестве 

осесимметричного четырехузлового элемента для теплового расчета используется PLANE55 
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(более подробную информацию об элементах, применяемых в тепловых расчетах, можно 

почерпнуть в справочной документации ANSYS). Осесимметричный режим элементов 

включается командой KEYOPT, либо через GUI (Prep7->Element Type->Add/Edit/Delete-

>Options->Element Behavior — Axisymmetric). Понятно, что при таком способе решения 

рассматриваемой задачи не могут быть учтены все особенности и неоднородности в окружном 

направлении (отверстия в деталях вращения и другие); 

• Болты, отверстия под болты и другие несимметричные элементы, к которым не 

моделируется подвод тепла через LINK34, представляются пластинами. Для этого выбирается 

поведение элемента PLANE55 Plane with thickness (Prep7->Element Type->Add/Edit/Delete-

>Options->Element Behavior — Plane w/thk). Такое поведение элемента PLANE55 требует 

задания дополнительных переменных (Real Constants). В качестве такой дополнительной 

переменной задается средняя толщина элемента, умноженная на их число. Средняя толщина 

должна назначаться таким образом, чтобы объем пера элемента был близок к объему пластины, 

моделирующей элемент; 

•   Элементы, к которым подводится тепло через LINK34 (лопатки, отверстия под воздух и 

т.д.), моделируются SHELL 57. В качестве Real Constants для данного элемента задаѐтся 

толщина одного элемента; 

•   Сетка на лопатках должна быть строго регулярной с элементами приблизительно 

равной площади. Это необходимо для моделирования конвекции от потока рабочего тела к перу 

лопатки (рис. 25); 

•   Для задания конвективного теплообмена используются одномерные элементы LINK34. 

Они связывают каждый узел пера с вершиной, к которой прикладывается температура потока 

(рис. 26); 

•   В качестве констант для элемента LINK34 задается площадь поверхности 

конвективного теплообмена. Эта площадь может быть определена по формуле: 

( 34)

пл
Э л

эл LINK

F
F К n

n
   

где плF — площадь пластины, nэл — число элементов LINK34, nл — число          лопаток, 

Кэ — коэффициент, учитывающий кривизну лопатки (отношение действительной площади  

поверхности  теплообмена к площади пластины); 

•   В качестве нагрузок в тепловом расчете задается конвективный теплообмен (в 

частности, коэффициент теплоотдачи и температура потока). В качестве граничных условий — 

температура узлов (все узлы обладают степенью свободы «температура»); 

•   При задании температуры потока следует учесть, что к статорным деталям 

прикладывается температура торможения, а к роторным — температура торможения в 

относительном движении. 
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Рис. 25. Сетка для моделирования лопаток 

 

 
Рис. 26. Элементы LINK34 на лопатке турбины 

4.2 Расчет элементов теплового состояния ротора 

на установившихся режимах 

Для расчета температурного состояния на установившихся режимах работы двигателя к 

созданной конечно-элементной модели прикладываются нагрузки, полученные в результате 

расчета системы внутренних воздушных потоков в программе ХПИ. На этом этапе интерес 

представляют значения коэффициентов теплоотдачи и температур воздуха в каналах системы. 

Приложение нагрузок осуществляется путем выполнения команды SF„CONV... (Prep7->Loads-

>Define Loads->Apply->Thermal->Convection->On nodes) и SFL„CONV... (Prep7->Loads->Define 

Loads->Apply->Thermal->Convection->On lines). В качестве параметра VALI (Film Coefficient) 

указывается коэффициент теплоотдачи a, VAL2I (Bulk Temperature) — температура воздушного 

потока.  

Для удобства приложения конвективной нагрузки предлагается создавать компоненты из 

узлов, элементов и др., которые соответствуют каналам, моделируемым при расчѐте 

гидравлики. Для создания компонентов необходимо выбрать через Select его составляющие 

(узлы, элементы и др.) и далее выполнить команду Select->Comp/Assembly->Create 

Component… задав имя компонента и его тип (рис. 27).  
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Рис. 27. Меню создания компонента 

Далее выбирается тип анализа — стационарный (Solution->Analysis Type->New Analysis 

— Steady-State). Для выполнения такого расчета, как правило, не требуется дополнительных 

настроек решения. Решение может быть запущено командой SOLVE. 
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5 РЕКОМЕНДАЦИИ ПО РАСЧЁТУ РАДИАЛЬНЫХ ЗАЗОРОВ 

ЛАБИРИНТНЫХ УПЛОТНЕНИЙ ДВИГАТЕЛЯ 

Рассмотрим процесс определения изменения геометрических размеров рассматриваемых 

элементов конструкции двигателя. В рассматриваемой расчетной модели будут учитываться 

следующие факторы: 

•   Температурные деформации элементов двигателя; 

•   Механические деформации от действия центробежных сил; 

•   Механические деформации от действия давлений на оболочки; 

•   Осевое перемещение элементов ротора от действия газовых сил.  

Полученные  ранее  результаты  расчета  распределения  температур   по элементам 

ротора находятся в файле с расширением *.rst.  

Для проведения структурного расчета необходимо переключить тип конечного элемента. 

Элемент PLANE55 представляет собой четырехузловой плоский конечный элемент для 

теплового расчета, поэтому он не может быть использован в структурном анализе. Аналогичная 

ситуация с SHELL57. В расчете деформаций ротора будет использоваться четырехузловой 

конечный элемент PLANE42. Для переключения необходимо выполнить команду 

ET,1,PLANE42 (если используется несколько групп конечных элементов, то вместо «1» нужно 

указать номер элемента). Используемые в тепловом расчете элементы LINK34 необходимо 

удалить. После замены элементов можно выбрать их поведение (осесимметричное, плоское 

напряженное состояние, плоское деформированное состояние, плоское напряженное состояние 

с заданием толщины). Это делается командой     KEYOPT,     либо     из     препроцессора     

(Prep7->Element     Type- >Add/Edit/Delete->Options->Element Behavior). 

Приложение распределения температур из теплового анализа осуществляется командой 

LDREAD,TEMP, либо из препроцессора (Prep7->Loads->Define Loads->Apply->Structural-

>Temperature->From Thermal Analysis, после чего выбираем файл с расширением *.rst). 

Помимо температурных нагрузок в проводимом расчете будет учтено влияние вращения 

элементов ротора, давлений на оболочки ротора и осевых сил, действующих на лопаточные 

венцы. Простым и удобным способом задания нагрузок является их представление как функции 

времени. Рассмотрим пример задания осевой силы на лопаточном венце 1РК компрессора ВД. 

Значение осевой силы на рабочем колесе ступени может быть определено по формуле: 

1 1 2 2 2 1( ),a a aP p F p F G c c       

где 1 2,p p  — статические давления на входе и выходе из колеса; 1 2,a ac c — осевые 

скорости на входе и выходе из колеса; 1 2,F F — кольцевые площади на входе и выходе из 

колеса; G — расход воздуха через ступень. 

Помимо изменения типа конечных элементов необходимо внести изменения и в свойства 

материалов модели. Необходимо определить структурные свойства (модуль упругости и 

коэффициент Пуассона), плотность материалов, коэффициент линейного расширения. 

Поскольку температуры деталей двигателя изменяются в широких пределах, а свойства 

материалов имеют ярко выраженную зависимость от температуры, то свойства материалов 

необходимо задавать с учетом их изменения по температуре. 
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6 РАСЧЁТ ТЕПЛОВОГО СОСТОЯНИЯ МИКРО ГАЗОТУРБИННОГО ДВИГАТЕЛЯ 

Для расчѐта необходимо подготовить 3 модели: 

– гидравлическая модель воздушной системы; 

– тепловая конечно-элементная модель; 

– структурная конечно-элементная модель. 

 

Гидравлический расчёт 

Воздушная система микро ГТД состоит из двух систем: 

– система охлаждения опоры, которая выполняет также роль системы наддува притрактовой 

полости турбины; 

– система охлаждения корпуса турбины. 

На первом этапе необходимо построить граф, ветви которого соответствуют 

охлаждающим каналам, а узлы местам соединения каналов в систему. Каждая ветвь 

соответствует отдельному каналу (кольцевой канал, круглый, между вращающимися дисками, 

уплотнение и др.). Исследуемый граф состоит из 11 ветвей и 13 узлов, 4 из которых являются 

свободными. Свободные узлы – это граничные узлы, расположенные на входе и на выходе из 

системы. В данных узлах задаются статическое давление и полная температура. 

Для проведения гидравлического расчѐта в программе расчѐта систем охлаждения газовых 

турбин (ХПИ) необходимо заполнить геометрические параметры каждой ветви двигателя, 

параметры режима (давление, температура в узлах и частота вращения ротора). Данные 

вводятся в электронную таблицу Microsoft Excel. 

Для расчѐта на ветвях были использованы следующие типы каналов: 

– 1-2, 3-4, 4-5, 5-6, 6-7, 11-12 – кольцевой канал; 

– 2-3, 7-8, 8-9 – течение вдоль вращающегося диска; 

– 10-11, 12-13 – плоский канал. 

 
Рис. 28. Система внутренних воздушных потоков микро ГТД 
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Лист «Геометрия» заполняются, как показано на рис. 29. В верхней части таблицы, где 

заполняются только общие параметры системы. Здесь необходимо обязательно указать число 

ветвей и число свободных узлов. В нижней части таблице каждая строка соответствует одному 

каналу. Здесь необходимо указать номер ветви, номера его входных и выходных узлов, тип 

канала и соответствующие этому типу канала данные. 

 

 
Рис. 29. Лист «Геометрия» 

 

Параметры воздуха на входе и на выходе из системы задаются в листе «Режим». Здесь 

необходимо указать номер свободного узла, статическое давление и полную температуру, а 

также частоту вращения вала. 

 
Рис. 30. Лист «Режим» 

 

Подогрев воздуха имеет сильное влияние на его параметры и поэтому расчѐт проводится с 

учѐтом подогрева воздуха о стенки каналов. Для учѐта подогрева воздуха необходимо указать 

температуры стенок каналов. Первоначально нам данные температуры, как правило, не 

известны. Поэтому на 1-ой итерации расчѐта данными значениями задаѐмся. Но следует 

отметить, чем точнее эти температуры будут заданы изначально, тем меньшее количество 

итераций потребуется для расчѐта. 
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Рис. 31. Лист «Температура стенки» 

В результате гидравлического расчѐта будут получены, помимо величин давлений и 

температур в узлах ветвей, также коэффициенты теплоотдачи необходимые для теплового 

анализа.  В данной программе имеется возможность при расчѐте создавать не только выходной 

файл результатов, но и макрос приложения тепловой нагрузки. Для того чтобы создать макрос 

необходимо указать имя макроса и выбрать файл с именами компонентов, соответствующих 

именам компонентов узлов или элементов каналов в ANSYS (рис. 32). 

 
Рис.32. Окно «GeneralWindow.exe» 

Файл, содержащий таблицу с именами компонентов, показан в левой части рис. 33. 
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Рис. 33. Таблица имен компонентов и параметр ТС 

Как правило, не к каждой ветви нужно писать макрос приложения тепловой нагрузки и 

поэтому в листе «Геометрия» присутствует параметр ТС. Для компонентов узлов в данной 

ячейке нужно поставить 0. Для тех случаев, когда писать команду приложения тепловой 

нагрузки нет необходимости, вводим в ячейке величину 50. 

Отметим, что для расчѐта файлы необходимо сохранить в формат *.csv или *.hyd. 

Разделители между целой и дробной части – точки, разделители между значениями – запятые. 

Для расчѐта, в приложении GeneralWindow.exe нужно выбрать необходимые файлы, 

указать имя файлу результатов и нажать кнопку . 

Результаты расчѐта показаны на рис. 34. 

  
Рис. 34. Результаты гидравлического расчѐта 
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Расчёт температурных полей 

Подготовка модели. 

Тепловой анализ будет проводиться на двухмерной осесимметричной модели. 

Используемые типы конечных элементов изображены на рис. 35. 

 
Рис.35. Типы конечных элементов 

 

Тип элемента 1 используется при создании КЭ модели для осесимметричных элементов 

конструкции. 

Тип элемента 2 используется для создания КЭ модели несимметричных элементов, таких 

ка например лопатки, отверстия и т.д. Для данных элементов необходимо определить также 

реальную константу, которая расчитывается по формуле 

el
el

el

V
R n

F
  ,  

где 

Vel – объѐм элемента, 

Fel – площадь проекции лопатки, 

nel – количество лопаток. 

Тип элемента 3 используется для приложения конвективного теплообмена на стенки в 

области камеры сгорания. 

Тип элемента 4 используется для создания элементов, на которые будет действовать 

излучение от стенок жаровой трубы. Для элементов данного типа необходимо определить 

постоянную Стефана-Больцмана, которая равна 
85.67 10 .  

После этого создаѐм модели материалов. Для теплового анализа необходимо определить 

следующие свойства: коэффициент теплопроводности и удельная теплоѐмкость. Данные 
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свойства вводятся для разных значений температур. Также для материалов элементов типа 4 

нужно задать в свойствах коэффициент черноты (Emissivity) равный 0.8. 

Созданная конечно-элементная модель показана на рис. 36. Жаровая труба в данном 

случае не была смоделирована. 

 
Рис.36. Конечно-элементная модель 

 

Расход вторичного воздуха камеры сгорания по пути следования вдоль жаровой трубы 

уменьшается (рис. 37), что приводит к уменьшению коэффициента теплоотдачи. Для задания 

градиента коэффициента теплоотдачи вдоль стенки рекомендуется создать элементы с 

поверхностным эффектом SURF151 (Type 3).  

 
Рис. 37. Камера сгорания 

С помощью команды Select Entities оставляем в активном наборе узлы, принадлежащие к 

поверхностям корпусов камеры сгорания (рис. 38). 
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Рис.38. Узлы стенки корпуса камеры сгорания 

Далее задаѐм атрибуты элемента (рис. 39). 

 
Рис. 39. Атрибуты элемента 

Создание элементов с поверхностным эффектом происходит командой Preprocessor > 

Modeling > Create > Elements > Surf / Contact > Surf Effect > No Extra Node. Далее нажимаем Pick 

All, после чего создаются элементы. Далее из этих элементов нужно создать компоненты, 

соответствующие участкам корпуса камеры сгорания. 

Для учѐта подогрева корпусов излучением от стенок жаровой трубы нужно создать 

элементы с поверхностным эффектом SURF 151 (Type 4). Также нужно создать внешний узел, 

где будет указана температура стенки жаровой трубы. Создание данных элементов аналогично 

созданию предыдущих элементов за исключением того, что имеется внешний узел. 

С помощью команды Select Entities оставляем в активном наборе узлы, принадлежащие к 

стенкам корпусов камеры сгорания, расположенные напротив жаровой трубы, а также внешний 

узел (рис. 40). 
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Рис. 40. Узлы стенки корпуса камеры сгорания и внешний узел 

Создание элементов с поверхностным эффектом происходит командой Preprocessor > 

Modeling > Create > Elements > Surf / Contact > Surf Effect > Extra Node. Далее нажимаем Pick 

All, после чего создаются элементы. В первой появившейся панели нажимаем Pick All для 

выбора всех активных узлов, появляется вторая панель — выбираем пространственный узел и 

нажимаем OK. 

 

Подготовка граничных условий 

В данном расчѐте будут использованы следующие граничные условия: 

– конвективный теплообмен в полостях гидравлической цепи (макрос приложения 

нагрузки создаѐтся при гидравлическом расчѐте); 

– конвективный теплообмен в полости между диском турбины и стенкой сопла; 

– конвективный теплообмен на стенках корпуса камеры сгорания; 

– теплообмен излучением от стенок жаровой трубы; 

– конвективный теплообмен в проточной части двигателя; 

– тепловой поток от подшипников. 

Конвективный теплообмен в полостях между диском турбины и стенкой сопла будем 

определять по формуле расчѐта средней теплоотдачи холодного диска, полученной Капиносом 

В М., Пустоваловым В. Н. и Рудько А. П. 

0.02Nu 20.3 Gr  , 

где Gr – число Грасгофа  

 max minGr Ga (T T )   , 

где Ga – Число Галилея 

 

3

n max

2

a R
Ga




 
 
 

, 

где Rmax – максимальный радиус полости; 
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na  - центростремительное ускорение; 

  - динамическая вязкость; 

  - плотность. 

  - коэффициент объѐмного расширения; 

Тmax, Тmin – максимальная и минимальная температура (выбираются из температуры 

стенки и температуры воздуха). 

Конвективный теплообмен на стенках корпуса камеры сгорания определяется по формуле 

расчѐта коэффициента теплоотдачи в кольцевом канале [15] 
0,4 0,8Nu 0,023 Pr Re   ,  

где Pr – число Прандтля (для воздуха ≈ 0.72); 

Re – число Рейнольдса 

Re ,





гG D

F
 

где G – массовый расход; 

Dг – гидравлический диаметр для кольцевого канала DГ=Dmax-Dmin;  

  - динамическая вязкость; 

F – площадь канала 

2 2

max min

4




D D
F  . 

Коэффициент теплоотдачи Nu
гD


  рассчитывается для входного и выходного 

сечений каждого компонента узлов камеры сгорания. Для приложения градиента конвекции к 

стенкам корпуса камеры сгорания можно воспользоваться макросом, показанным на рис. 41. 

Для расчѐта излучения от жаровой трубы необходимо приложить температуру к 

внешнему узлу. Расчѐт с учѐтом излучения требует задания величины смещения по 

температуре — это разница между абсолютным нулѐм и нулѐм в текущей системе измерения. 

Например, если при анализе температура задаѐтся в градусах Цельсия, то смещение по 

температуре будет равно 273,15. Смещение по температуре задаѐтся командой 

TOFFST,VALUE, где VALUE — величина смещения. 
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Рис. 41. Приложения конвекции к стенкам камеры сгорания 

В узлах, где осуществляется выделение тепла, задаются величинами теплового потока 

Heat Flow. Количество тепла, выделяемого от трения в подшипниках, описывается уравнением: 

TPNQ   

Nтр – мощность трения, которая рассчитывается по формуле:  

ndTfNTP   

где T – приведенная нагрузка на подшипник, которая рассчитывается по формуле; 

f – коэффициент трения (рол. 0,0025…0,01; шариковый 0,001…0,004); 

d – диаметр вала; 

n – число оборотов.  

Tk kkkmART )( 
 

где R – радиальная нагрузка, определяется из условия распределения веса ротора по 

опорам; 

А – осевая нагрузка; 
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m – коэффициент приведения осевой силы к условной радиальной. Зависит от типа и 

серии, от внутреннего диаметра, а также от отношения R/A (шарикоподшипник ≈2, 

роликоподшипник 0); 

kσ – коэффициент, учитывающий условия работы подшипника (примем 1,05); 

kk – коэффициент учитывающий вращение (примем 1); 

kT – коэффициент, учитывающий температурный режим работы подшипника (примем 

1,25). 

Поскольку в данном двигателе нет охлаждаемых лопаток, поэтому приближѐнно в 

качестве граничных условий лопаток и трактовых стенок можно задать температуры, 

полученные в газодинамическом расчѐте (
*

wT  - для роторных лопаток и 
*T  - для лопаток 

статора). 

 

Расчёт и анализ результатов 

После того, как все граничные условия заданы, запускаем расчѐт на решение Solution > 

Solve > Current LS. Результаты расчѐта показаны на рис. 42. 

 
Рис.42. Распределение температурных полей микро ГТД 

После этого проводится сравнение полученной средней температуры стенок каналов с 

заданными в гидравлическом расчѐте значениями. Затем проводим новый цикл расчѐтов и т.д. 

до достижения заданной точности. Критерий сходимости по средней температуре на 

компоненте – разница с предыдущим расчетом менее одного градуса °С. 
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7 РАСЧЁТ ЛАБИРИНТНОГО УПЛОТНЕНИЯ 

В данном примере рассматривается система наддува РТКУ масляной полости средней 

опоры двигателя НК-93 (рис. 43). Воздух для функционирования данной системы отбирается  

перед первым рабочим колесом компрессора ВД и выбрасывается во второй контур. На пути 

следования воздуха от входа к выходу системы встречаются следующие каналы: лабиринтные 

уплотнения, каналы между диском и корпусом, кольцевой канал, плоский канал, трубопроводы. 

Из-за незначительных утечек через РТКУ (обычно до 2 г/с) данный канал учитывать в расчѐте 

не будем. Система будет работать правильно в том случае, если будет обеспечиваться 

необходимый перепад давления между воздушной и масляной полостью, а также когда 

радиально-упорный подшипник будет воспринимать осевую нагрузку в допустимом диапазоне. 

В данной работе рассматривается только обеспечение перепада на РТКУ. Из рекомендаций 

следует, что перепад на взлѐтном режиме работы необходимо обеспечить 0,5 атм. В масляной 

полости примем давление равным 1,2 атм. Исходя из этого, давление воздуха в предмасляной 

полости необходимо получить 1,7 атм. 

 
Рис. 43. Система наддува РТКУ средней опоры НК-93 

По данной системе строим граф, представляя каждый канал в виде ветви, а места 

соединения ветвей в виде узлов (рис. 44). 
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Рис. 44. Граф воздушной системы наддува уплотнения 

Для проведения гидравлического расчѐта необходимо создать 3 файла: геометрии (рис. 

13), параметров режима (рис. 22) и средних температур стенок каналов (рис. 23). Файл 

компонентов создаѐтся только при необходимости проведения теплового расчѐта. 

Необходимо отметить, что не все геометрические параметры представляется возможным 

снять с учебного продольного разреза двигателя. Поэтому некоторыми параметрами, такими 

как радиальный зазор лабиринтного уплотнения, количество отверстий и пазов, в первом 

приближении задаемся. 

Файл параметров режима формируется исходя из термогазодинамического расчѐта. 

Файл средних температур стенок каналов формируется по прототипу, в ином случае в 

первом приближении. 

Проведѐм расчѐт воздушной системы в программе ХПИ. Результаты представлены в 

табл. 4 и 5. 
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Табл. 4. Геометрические характеристики каналов 

  

Табл. 5. Результаты расчѐта 

 

В табл. 4 представлены данные, носящие только информативный характер. 

Из результатов расчѐтов видно, что давление в узле 7 получено 1,51 атм. Существует 

множество вариантов регулирования этого параметра. В данном случае был выбран случай 

изменения радиального зазора нижнего лабиринтного уплотнения.  

Проведѐм ряд расчѐтов для различных радиальных зазоров и построим зависимость 

(рис. 45). 
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Рис. 45. Зависимость давления в узле 7 от величины радиального зазора  

в лабиринтном уплотнении 

Из рис. 45 видно, что необходимое давление в узле 7 обеспечивается при величине 

рабочего радиального зазора в лабиринтном уплотнении равной 0,3мм. 

В табл. 6 представлены результаты окончательного расчѐта воздушной системы. 

 Табл. 6. Результаты окончательного расчѐта 

 

На рис. 46 нанесены относительные значения параметров воздуха (давление, температура 

и расход воздуха). 
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Рис. 46. Гидравлические параметры системы  

верхнее значение - относительное давление;  

нижнее значение - относительная температура 

На рис. 47 нанесены значения параметров конвекции (средняя температура воздуха в 

канале и коэффициент теплоотдачи). 
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Рис. 47. Параметры конвекции  

верхнее значение - температура, 
o
С;  

нижнее значение - коэффициент теплоотдачи, 
К

2
м

Вт
 

В результате проведѐнной работы была подобрана величина рабочего радиального зазора 

нижнего лабиринтного уплотнения 0,3мм и тем самым обеспечен необходимый перепад 

давления на РТКУ. Нужно отметить, что зазор в процессе работы двигателя меняется от 

действия температуры, центробежной силы, давлений в полостях и др. Поэтому, чтобы 

назначить монтажный радиальный зазор необходимо определить перемещения роторных и 

статорных элементов уплотнения на рабочих режимах двигателя. 
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ЗАКЛЮЧЕНИЕ 

Составленное учебное пособие «Формирование сопряжѐнной модели системы 

внутренних воздушных потоков, теплового нагружения конструкции двигателей, процессов в 

уплотнениях и опорах», обеспечивает пошаговое обучение расчету воздушных систем и 

теплового состояния газотурбинного двигателя. 

В пособии приведены примеры воздушных систем газотурбинного двигателя. 

Приведенные методики расчѐта гидравлических параметров, теплового состояния и 

напряжѐнно-деформированного состояния элементов двигателя позволяют определить перепад 

давления на уплотнениях, осевую силу, действующую на радиально-упорный подшипник и 

радиальные зазоры в лабиринтных уплотнениях и в лопаточных венцах. 

Расчет воздушных систем проводился с помощью программных пакетов ХПИ и ANSYS. 

Было смоделировано тепловое состояние микро газотурбинного двигателя. Результатом расчета 

являются параметры системы внутреннего воздухоснабжения и  температурные поля элементов 

двигателя. Также было проведено исследование лабиринтного уплотнения предмасляной 

полости опоры компрессора. 
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